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TOPIC -----------------------------------------------------------

This article contains the ReadMe file for the Desktop PrintMonitor 2.0
software.

DISCUSSION ------------------------------------------------------

Desktop PrintMonitor 2.0

This document contains some late-breaking information and tips not included in
the manual that came with your printer. You may want to print this document and
keep it for future reference.

The topics are:

• System Recommendations
• New Features in Version 2.0
• Hints and Shortcuts
• How to Use Desktop PrintMonitor
• Support and Compatibility Information
• Troubleshooting Tips
• Software Components Installed With Desktop PrintMonitor

System Recommendations

• An Apple Macintosh or PowerBook personal computer with a 68020 or later
processor, a Power Macintosh, or another Mac OS-based personal computer
• 5 megabytes (MB) of RAM
• Macintosh Operating System (Mac OS) version 7.1 or later

New Features in Version 2.0

• Desktop printer icons can be moved off the desktop and into folders.
• A printer menu located on the right-hand side of the menu bar provides a
convenient means to switch the user’s default printer.
• A control strip module with functionality identical to the printer menu is
provided for PowerBook systems and other systems employing the Control Strip
software.

Hints and Shortcuts
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• The Desktop Printers folder in the Apple Menu provides a convenient shortcut
to desktop
printers.  This is especially helpful if you have moved your desktop printer
icons off the desktop.
• Command-L key combination is a shortcut equivalent to the Set Default Printer
command in the Printing menu.
• Holding down the Option and Shift keys makes the Hold and Resume buttons
function as Stop Print Queue and Start Print Queue.
• To print additional copies of a file, you can select the spool file waiting in
the print queue and choose Duplicate from the File menu.

How to Use Desktop PrintMonitor

Creating Desktop Printers
You create desktop printers by selecting a printer in the Chooser. A desktop
printer icon appears on your desktop when you close the Chooser.

The printer icon is initially placed on the desktop. After the icon is created,
you can move it to any location on your startup drive.

If you wish to create other desktop printers, you must open the Chooser and
select the desired printers one at a time. You must close the Chooser each time
to create a desktop printer.

The last desktop printer created becomes the default printer. Your documents
will automatically be printed on the default printer.

Printing With Desktop Printers
You can print documents within your applications as you normally do. You can
also print documents without leaving the Finder, using one of the two methods
described here. These methods are particularly efficient when you have a number
of documents you want to print at once.

• Drag the icons of the documents you want to print to the desktop icon of the
printer you want to use.
• Select the icons of the documents you want to print and choose the Print
command from the File menu.

The Print dialog box appears. Make your choices, then click the Print button.

After a few moments, the document starts to print. If background printing is
turned on, you can continue working while the document is printing.

Selecting a Default Printer
If you have more than one printer available, you can select which you want to
use. The printer you select is called the default printer. All your documents
will be printed on the default printer until you select a new one.

To change the default printer, use one of these five methods:



• Drag the document you want to print to a desktop printer icon, and it will
automatically become the default printer.
• Select the desktop printer icon and use the Printing menu to set the printer
as the default.
• Select a new printer using the Chooser.
• Select the printer name in the System Printer Menu.
• Select the printer name from the Control Strip.

Note:  Switching between printers may change how much information you can fit on
a page. It’s best to choose a printer before you spend much time formatting the
document.

Working With Desktop Printer Icons

Desktop printer icons change to indicate printing status:

[ Graphics Not Available in Tech Info Library Article ]

You can do the following with desktop printer icons:

• Throw away the icon. Drag the icon to the Trash. You can’t throw away a
desktop printer icon while the printer is printing a document. (You can create
another desktop printer icon for that printer whenever you like.)

Note:  You must always have at least one printer icon on your desktop. If  you
throw away the last icon, it will immediately be created again.

• Rename the icon.  Rename the icon as you would any other Finder icon. Click
the name to highlight it, then type the new name. This changes the name of the
icon, not the name of the printer.

• Create an alias for the icon.  You may create an alias for the icon as you
would any Finder icon, by selecting the icon and choosing the Make Alias command
from the File menu.

Monitoring Printing
-------------------
If you are using background printing, you can use the desktop printer features
to monitor and control the documents that are waiting to print. To learn how to
turn background printing on and off, see your printer manual.

To monitor the printing of documents:

1. Double-click the desktop printer icon you’re interested in.

A window opens listing the documents that are printing or waiting to print.

Watching the status messages can be helpful when troubleshooting printing
problems. When more than one job is waiting to be printed, a list of print jobs
appears in the waiting list, showing the order in which they will be printed
(when sorted by print time.)



2. Choose what you’d like to do:

• To cancel a print request, select it by clicking its title or icon and click
the Trash icon button
You can also drag the icon for the print request to the Trash. Note that these
methods delete only the print request (also referred to as a spool file), not
the document itself.

• To put a print request on hold, select it and click the Hold button.

The print request will stay on hold until you select it again and click the
Resume button. You can also put the document that’s currently printing on hold
by dragging it to the list of documents waiting to print (lower part of the
window).

• To indicate that a print request is urgent, select it and put it on hold.
Next, click the Set Print Time icon button. In the dialog box that opens, click
Urgent.  Another way to make a job urgent is to drag the job from the waiting
area of the print queue to the top of the queue or to the area reserved for the
currently printing job.

• To indicate that a print request should not print until a future time, select
it and click the Set Print Time icon button. In the dialog box that opens, click
At Time, then set the time you want.

• To change the order of the items waiting to print, drag their titles up or
down in the list.

• To sort the list of documents waiting to print, click the title of the column
you want to sort by.

For example, to sort by the name of the document, click Document Name (you can
also sort by choosing the commands in the View menu).  The column title you
sorted by is underlined. Sorting the items does not change the order in which
they will print. To see that order, sort by Print Time.

• To temporarily stop all documents from printing on this printer, choose Stop
Print Queue from the Printing menu.

To resume using the printer, choose Start Print Queue from the Printing menu.

Shortcut: The Printing menu for starting and stopping the print queue is
available without opening the window for the printer, as long as the printer’s
icon is selected.

• To move a print request from one printer to another printer of the same type
(for example, from a LaserWriter 4/600 PS to a LaserWriter 16/600 PS), drag the
icon for the print request to the icon of the printer where you want to move
it.

You can only move a print request from a PostScript printer to another
PostScript printer. The printing software won’t let you move a print request to
an incompatible printer. For example, you can’t move a request from a



LaserWriter printer to a StyleWriter printer.

Turning Off or Removing the Desktop Printing Software

Removing a Desktop Printer Icon

You can remove an individual desktop printer icon by dragging it into the Trash.
If you have only one desktop printer, you can’t get rid of the icon by dragging
it to the Trash (the icon will reappear if you do). To get rid of the desktop
printer, you must first select a different desktop printer as the default
printer and then drag the desktop printer icon to the Trash. If you don’t want
to use desktop printer icons, see “Turning Off the Desktop PrintMonitor” or
“Removing Desktop Printing Software” for information about how to remove the
desktop printer software.

Turning Off the Desktop PrintMonitor

If you don’t want to use desktop printers, you can turn off the Desktop
PrintMonitor using the Extensions Manager (available with version System 7.5 of
the Mac OS).

To turn off the Desktop PrintMonitor:

1. Open the Extensions Manager control panel in the Control Panels folder.
2. Click to deselect (uncheck) the Desktop PrintMonitor, Desktop Printer
Extension, Desktop Printer Spooler, and Desktop Printer Menu extensions in the
panel.
3. Click the close box to close the control panel.
4. Restart your computer.

Removing the Desktop Printing Software

The desktop printing software uses both the Desktop PrintMonitor and the
PrintMonitor software. The Desktop PrintMonitor requires 200-400K bytes more
free system memory in addition to the memory required by the PrintMonitor.  If
you don’t want to use the desktop printing software, you can remove it.

To remove desktop printing software:

1.  Drag any print spool files found in the PrintMonitor Documents folder (in
the System Folder) to the Trash.

WARNING: These jobs will not be printed.

2. Restart your computer with the extensions off by holding down the Shift key
and choosing Restart from the Special menu. Hold the Shift key down until the
message “Extensions Off” appears or until your normal desktop appears.

3. Drag the following files from the Extensions folder to the Trash:

Desktop PrintMonitor
Desktop Printer Spooler
Desktop Printer Extension



Desktop Printer Menu

4. Restart your computer.

Support and Compatibility Information

• Some third-party printers do not support desktop printing. If your printer is
not an Apple product, and no desktop printer icon is created after you select
your printer in the Chooser, it is likely that your printer does not support
Desktop PrintMonitor.  Please contact the vendor of your printer to see if there
is a version of the driver that is compatible with Desktop PrintMonitor.

• When you choose Save or Open in your application programs, you will see your
desktop printers listed as if they were folders, but you should not save or open
any documents in them. If you do, you will not be able to access your
documents.

• Desktop PrintMontitor supports drag-and-drop printing for all files that cause
the Print Command in the File menu to become enabled.  Since clipping files do
not enable the Print  command, drag and drop is not supported for them.

• Apple’s Fax Sender software is not supported by Desktop PrintMonitor. Fax
Sender is fully functional when Desktop PrintMonitor is installed; however, it
does not get the benefit of Desktop PrintMonitor’s features. When you select Fax
Sender in the Chooser, you will not have a default desktop printer until you
choose a printer icon and choose Set Default Printer from the Printing menu.

Troubleshooting Tips

Error message “-192” or “15”

Problem: After installing Desktop PrintMonitor and restarting your Mac OS–based
computer, you see error message “-192” or “15” when you try opening files or
folders in the Finder. This may occur when Now Startup Manager’s preferences
file has become corrupted.

Solution: Restart your computer with extensions disabled (hold down the Shift
key while restarting), delete Now Startup Manager’s preferences file, and
restart the computer again with extensions enabled.  Important:  Before deleting
your Now Norton Startup preferences, you may want to record them or write them
down before you delete this file.

Desktop printer cannot be found

Problem: When you try to print, your spool files are moved to the Trash and an
alert message is displayed saying that the desktop printer could not be found.

Solution: There are two likely solutions to this problem. First, it is possible
that your desktop printer has somehow become damaged. To fix this, drag the
desktop printer icon to the Trash and reselect the printer in the Chooser. A new
desktop printer icon will be created.



Second, your printer software may not be using a file format that is completely
compatible with Desktop PrintMonitor. If your printer software is not published
by either Apple Computer or Adobe Systems, it is possible that it is not making
proper and legitimate use of PrintMonitor. If this is the case, your printer
software will not work properly with Desktop PrintMonitor. The only resolution
to this problem is to disable Desktop PrintMonitor and use old PrintMonitor.  To
print the documents you were working on follow these steps:

1. Empty the Trash.
2. Go to the Chooser and turn off background printing.
3. Print documents again.
To correct desktop printing:
4. Drag the desktop printer to the Trash.
5. Go to the Chooser and turn background printing back on.
6. Create a new desktop printer.

Not enough memory message when dragging files to desktop printer

Problem:  When you drag documents created by different software applications to
your desktop printer icon, a message is displayed indicating that there is not
enough memory to continue.

Solution:  The application used to create a document will launch when the
document is printed.  You may not have enough memory available to launch all of
the software applications corresponding to the documents you have selected. You
can resolve this situation by printing your documents individually or in smaller
groups.

Options dimmed in Printing menu

Problem:   Get Printer Info  and  Change Setup commands appear in your Printing
menu, but can’t be selected.

Solution:  These are two new functions supported by LaserWriter v8.4.  If these
or other items in the menu appear dimmed and cannot be selected, it is because
you are using a version of the printing software that doesn’t support their
respective functions.

“Out of Paper” message remains

Problem: The LaserWriter 300 “Out of Paper” message doesn’t automatically go
away when paper is added to the printer.

Solution:  This feature does not work with Desktop PrintMonitor and LaserWriter
300 driver.  The only way to work around this problem is to disable Desktop
PrintMonitor and use old PrintMonitor.

Documents printed to Color StyleWriter vary in appearance

Problem: Documents printed to your Color StyleWriter look different if their
printing is resumed on page two (or any later page).

Solution:  With the current version of Desktop PrintMonitor and the Color



StyleWriter, it is possible to lose color-matching information if a print job is
put on hold and then resumed on a later page. The best way to address this
problem is to resume printing on page one.

Software Components Installed With Desktop PrintMonitor

The Desktop PrintMonitor Installer places the following files in your System
Folder:

• Desktop Printer Extension (in Extensions folder)
• Desktop PrintMonitor (in Extensions folder)
• Desktop Printer Spooler (in Extensions folder)
• Desktop Printer Menu (in Extensions folder)
• Printer Selector (in Control Strip Modules folder, if it exists)

If you are using a version of the Mac OS earlier than System 7.5.1, you also
get:

• Finder 7.5.1 (in System Folder) provides improved compatibility
• Finder Help and Network Extension (in Extensions folder) to support Finder
7.5.1
• Clipping Extension, Dragging Enabler, Macintosh Drag and Drop, and Thread
Manager (in Extensions folder) to support the interface and messages within
Desktop PrintMonitor
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